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1. Do not open the booklet unless you are 

asked to do so. 

 1. iz'u&iqfLrdk dks rc rd u [kksysa tc rd vkils 

dgk u tk,A 

2. The booklet contains 100 questions. 

Examinee is required to answer 75 questions 

in the OMR Answer-Sheet provided and not 

in the question booklet.  All questions carry 

equal marks. 

 2. iz'u&iqfLrdk esa 100 iz'u gSaA ijh{kkFkhZ dks 75 iz'uksa 

dks dsoy nh xbZ OMR vkUlj&'khV ij gh gy djuk 

gS] iz'u&iqfLrdk ij ughaA lHkh iz'uksa ds vad leku 

gSaA 

3. Examine the Booklet and the OMR Answer-

Sheet very carefully before you proceed. 

Faulty question booklet due to missing or 

duplicate pages/questions or having any 

other discrepancy should be got immediately 

replaced. 

 3. iz'uksa ds mÙkj vafdr djus ls iwoZ iz'u&iqfLrdk rFkk 

OMR vkUlj&'khV dks lko/kkuhiwoZd ns[k ysaA 

nks"kiw.kZ iz'u&iqfLrdk ftlesa dqN Hkkx Nius ls NwV x, 

gksa ;k iz'u ,d ls vf/kd ckj Ni x, gksa ;k mlesa 

fdlh vU; izdkj dh deh gks] rks mls rqjUr cny ysaA 
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1. 20]480 fdyksckbV (KB) fdrus esxkckbV 

(MB) ds cjkcj gksxk \ 

 
1. 20,480 kilobytes (KB) is equal to how 

many megabytes ? 

(A) 5 MB  (A) 5 MB 

(B) 10 MB  (B) 10 MB 

(C) 20 MB  (C) 20 MB 

(D) 40 MB  (D) 40 MB 

2. SPSS lkW¶Vos;j esa lkaf[;dh; fo'ys"k.k ds 

fy, dkSu&lk MsVk çdkj lcls mi;qä gS \ 

 
2. Which type of data is most appropriate 

for statistical analysis in SPSS 

software ? 

(A) eYVhehfM;k MsVk (vkWfM;ks@ohfM;ks)  (A) Multimedia data (audio/video)  

(B) ek=kRed la[;kRed MsVk  (B) Quantitative numerical data 

(C) vlajfpr fp= MsVk  (C) Unstructured image data 

(D) dPpk flXuy MsVk  (D) Raw signal data 

3. SPSS esa] dkbZ&LDok;j ijh{k.k djus ds fy, 

fdl lqfo/kk dk mi;ksx fd;k tkrk gS \ 

 
3. In SPSS, which feature is used to 

perform a Chi-square test ? 

(A) File > New > Chi-Square  (A) File > New > Chi-Square 

(B) Analyze > Descriptive Statistics > 

Crosstabs 

 (B) Analyze > Descriptive Statistics 

> Crosstabs 

(C) Edit > Options > Chi-Square  (C) Edit > Options > Chi-Square 

(D) View > Toolbar > Chi-Square  (D) View> Toolbar > Chi-Square 

4. SPSS dk çkFkfed mi;ksx fdlds fy, 

fd;k tkrk gS \ 

 
4. What is SPSS primarily used for ? 

(A) MsVkcsl çca/ku  (A) Database management 

(B) ohfM;ks laiknu  (B) Video editing 

(C) osclkbV fodkl  (C) Website development 

(D) lkaf[;dh; fo'ys"k.k  (D) Statistical analysis 
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5. vki MS ,Dlsy esa vko`fÙk forj.k rkfydk 

dSls cuk ldrs gSa \ 

 
5. How can you create a frequency 

distribution table in MS Excel ? 

(A) lkWVZ lqfo/kk dk mi;ksx djdj  (A) By using the Sort feature 

(B) lsy esa MsVk dks eSU;qvy :i ls ntZ 

djds 

 (B) By manually entering data into 

cells 

(C) fioV Vscy lqfo/kk dk mi;ksx djds  (C) By using the PivotTable feature 

(D) etZ lqfo/kk dk mi;ksx djds  (D) By using the Merge feature 

6. ,d MsVk lsV dk ekud fopyu fudkyus ds 

fy, vki dkSu&lk ,Dlsy QaD'ku mi;ksx 

djsaxs \ 

 
6. Which Excel function would you use 

to calculate the standard deviation of a 

dataset ? 

(A) =STDEV()  (A) =STDEV()  

(B) =AVERAGE()  (B) =AVERAGE()  

(C) =SUM()  (C) =SUM()  

(D) =MEDIAN()  (D) =MEDIAN()  

7. MS ,Dlsy ds lkaf[;dh; dk;ksaZ dk mi;ksx 

djds fuEufyf[kr esa ls fdldh x.kuk dh 

tk ldrh gS \ 

 
7. Which of the following can be 

calculated using MS Excel’s statistical 

functions ? 

(A) Mh,u, vuqØe.k  (A) DNA sequencing 

(B) vkSlr] ekf/;dk] cgqyd] vkSj ekud 

fopyu 

 (B) Mean, median, mode, and 

standard deviation 

(C) thu laiknu  (C) Gene editing 

(D) çksVhu la'ys"k.k  (D) Protein synthesis 
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8. dkbZ&LDok;j ijh{k.k ykxw djus ds fy, 

fuEufyf[kr esa ls dkSu&lh vko';drk gS \ 

 
8. Which of the following is a 

requirement for applying the chi-

square test ? 

(A) MsVk Js.kh; gksuk pkfg,  (A) The data must be categorical 

(B) MsVk lkekU; :i ls forfjr gksuk 

pkfg, 

 (B) The data must be normally 

distributed 

(C) MsVk fujarj gksuk pkfg,  (C) The data must be continuous 

(D) uewus dk vkdkj NksVk gksuk pkfg,  (D) The sample size must be small 

9. dkbZ&LDok;j ijh{k.k dk çkFkfed mís'; D;k 

gS \ 

 
9. What is the primary purpose of the 

Chi-square test ? 

(A) ,d uewus dh ekf/;dk [kkstuk  (A) To find the median of a sample 

(B) ,d MsVk lsV dk vkSlr fudkyuk  (B) To calculate the mean of a data 

set 

(C) nks Js.kh; pj ds chp la?k dk ijh{k.k 

djuk 

 (C) To test the association between 

two categorical variables 

(D) ekud fopyu dk fu/kkZj.k djuk  (D) To determine the standard 

deviation 

10. vkSlr dh ekud =qfV (SEM) D;k n'kkZrh  

gS \ 

 
10. What does the standard error of the 

mean (SEM) represent ? 

(A) tula[;k vkSlr ds uewuk vkSlr 

vuqeku dh ifjorZu'khyrk 

 (A) The variability of the sample 

mean estimate of a population 

mean 

(B) MsVk fcanqvksa dh dqy la[;k  (B) The total number of data points 

(C) MsVk dh Js.kh  (C) The range of the data 

(D) MsVk lsV dk ekud fopyu  (D) The standard deviation of the 

data set 
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11. ekud fopyu D;k gS \ 

 
11. What is the standard deviation ? 

(A) vkSlr ds pkjksa vksj MsVk fcanqvksa ds 

çlkj dk eki 

 (A) A measure of the dispersion of 

data points around the mean 

(B) ,d MsVk lsV dk vkSlr eku  (B) The average value of a dataset 

(C) ,d MsVk lsV esa mPpre eku  (C) The highest value in a dataset 

(D) ,d MsVk lsV dh ekf/;dk  (D) The median of a dataset 

12. MsVk lsV esa fHkUurk xq.kkad (CV) D;k ekirk 

gS \ 

 
12. What does the coefficient of variation 

(CV) measure in a dataset ? 

(A) vkSlr ds fy, ekud fopyu dk 

vuqikr 

 (A) The ratio of standard deviation 

to the mean 

(B) mPpre vkSj fuEure ewY;ksa ds chp 

dk varj 

 (B) The difference between the 

highest and lowest values 

(C) vkSlr ls oxk±rjksa dk vkSlr  (C) The average of the squared 

differences from the mean 

(D) lHkh MsVk fcanqvksa dk ;ksx  (D) The sum of all data points 

13. ,d MsVk lsV esa] cgqyd D;k n'kkZrk gS \ 

 
13. In a data set, the mode represents 

which of the following ? 

(A) e/; eku  (A) The middle value 

(B) lHkh ewY;ksa dk vkSlr  (B) The average of all values 

(C) og eku tks lcls vf/kd ckj çdV 

gksrk gS 

 (C) The value that appears most 

frequently 

(D) vf/kdre vkSj U;wure ewY;ksa ds chp 

dk varj 

 (D) The difference between 

maximum and minimum values 
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14. vadxf.krh; vkSlr D;k gS \ 

 
14. What is the arithmetic mean ? 

(A) lHkh ewY;ksa dk ;ksx tks ewY; la[;k ls 

foHkkftr gks 

 (A) The sum of all values divided by 

the number of values 

(B) fdlh Øec¼ MsVk lsV esa e/; eku  (B) The middle value in a sorted data 

set 

(C) ,d MsVk lsV esa lcls vf/kd ckj 

fn[kkbZ nsus okyk eku 

 (C) The value that appears most 

frequently in a data set 

(D) mPpre vkSj fuEure eku ds chp dk 

varj 

 (D) The difference between the 

highest and lowest values 

15. fuEufyf[kr esa ls dkSu dsaæh; ço`fÙk dk eki 

ugha gS \ 

 
15. Which of the following is NOT a 

measure of central tendency ? 

(A) cgqyd  (A) Mode 

(B) vkSlr  (B) Mean 

(C) ekf/;dk  (C) Median 

(D) foHksnu  (D) Variance 

16. lkaf[;dh; fo'ys"k.k esa ÝhDosalh 

fMLVªhC;w'ku (vko`fÙk forj.k) D;k n'kkZrk  

gS \ 

 
16. What does a frequency distribution 

represent in statistical analysis ? 

(A) ;g lkjka'k fd dksbZ eku fdlh MsVk 

lsV esa fdruh ckj vkrk gSA 

 (A) A summary of how often each 

value appears in a dataset 

(B) vkSlr eku dh x.kuk dh ,d fof/k  (B) A method for calculating mean 

values 

(C) ifjdYiuk ijh{k.k dh ,d çfØ;k  (C) A step involved in hypothesis 

testing 

(D) fjxzs'ku fo'ys"k.k ds fy, ,d 

xzkfQdy Vwy 

 (D) A graphical tool for regression 

analysis 
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17. ç.kkyhc¼ uewukdj.k esa] uewus dSls pqus tkrs 

gSa \ 

 17. In systematic sampling, how are 

samples selected ? 

(A) tula[;k dks LrjhÏr djds vkSj 

çR;sd lewg ls p;u djds 

 (A) By stratifying the population and 

selecting from each group 

(B) tula[;k ls O;fä;ksa dk ;kn`fPNd 

:i ls p;u djds 

 (B) By randomly picking individuals 

from the population 

(C) dsoy igys O;fä;ksa dk p;u djds  (C) By choosing only the first 

individuals 

(D) tula[;k ls çR;sd nosa O;fä dk 

p;u djds 

 (D) By selecting every nth individual 

from the population 

18. LrjhÏr uewukdj.k D;k gS \  18. What is stratified sampling ? 

(A) dsoy igys dqN O;fä;ksa dk uewuk 

ysuk 

 (A) Sampling only the first few 

individuals 

(B) fcuk fdlh lewg ds O;fä;ksa dk 

;kn`fPNd :i ls p;u 

 (B) Randomly selecting individuals 

without any grouping 

(C) tula[;k dks milewgksa esa foHkkftr 

djds çR;sd milewg dk uewuk ysuk 

 (C) Dividing the population into 

subgroups and sampling each 

subgroup 

(D) tula[;k ls çR;sd nosa O;fä dk 

p;u djuk 

 (D) Selecting every nth individual 

from the population 

19. ;kn`fPNd uewukdj.k D;k gS \  19. What is random sampling ? 

(A) 'kks/kdrkZ dh ilan ds vk/kkj ij uewus 

dk p;u 

 (A) Selecting samples based on 

researcher preference 

(B) ,d fof/k ftlesa tula[;k ds çR;sd 

lnL; ds p;u dh leku laHkkouk 

gksrh gSA 

 (B) A method where each member 

of the population has an equal 

chance of being selected 

(C) dsoy NksVh tula[;kvksa ds fy, 

mi;ksx dh tkus okyh fof/k 

 (C) A method used only for small 

populations 

(D) uewuksa dks ,d fof'k"V Øe esa pquuk  (D) Choosing samples in a specific 

sequence 



 

B170602T ( 8 )  Set-C 

20. ck;ksesVªh esa tula[;k D;k gS \ 

 
20. In biometry, what is a population ? 

(A) v/;;u ds rgr lHkh O;fä;ksa ;k 

oLrqvksa dk laxzg 

 (A) A collection of all individuals or 

items under study 

(B) ,d cM+s lewg dk milewg  (B) A subset of a larger group 

(C) tkuojksa dk ,d lewg  (C) A group of animals 

(D) MsVk fcanqvksa dk ,d uewuk  (D) A sample of data points 

21. tc nks fu"i{k Ng&i{kh; ikls Qsads tkrs gSa] 

rks dqy ;ksx 7 vkus dh çkf;drk D;k gS \ 

 
21. When two fair six-sided dice are 

rolled, what is the probability of 

obtaining a total sum of 7 ? 

(A) 5/36  (A) 5/36 

(B) 6/36  (B) 6/36 

(C) 7/36  (C) 7/36 

(D) 1/12  (D) 1/12 

22. ,d FkSys esa 3 yky] 7 uhyh vkSj 10 gjh xsansa 

gSaA ;fn ,d xsan ;kn`fPNd :i ls pquh tk,] 

rks gjh xsan feyus dh çkf;drk D;k gksxh \ 

 
22. A bag contains 3 red, 7 blue, and 10 

green balls. If one ball is drawn at 

random, what is the probability of 

selecting a green ball ? 

(A) 3/20  (A) 3/20 

(B) 7/20  (B) 7/20 

(C) 10/20  (C) 10/20 

(D) 13/20  (D) 13/20 

23. MsVk lsV 45] 50] 55] 60] 65 esa ekf/;dk 

(Median) D;k gS \ 

 
23. In the data set 45, 50, 55, 60, 65, what 

is the median value ? 

(A) 50  (A) 50 

(B) 55  (B) 55 

(C) 60  (C) 60 

(D) 65   (D) 65 
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24. ,d v/;;u esa 8 jksfx;ksa dk otu 

(fdyksxzke esa) bl çdkj ntZ fd;k x;k gS % 

50] 55] 60] 65] 70] 75] 80] 85A jksfx;ksa 

dk vkSlr otu D;k gS \ 

 24. A study records the weights (in kg) of 

8 patients as : 50, 55, 60, 65, 70, 75, 

80, 85. What is the mean weight of the 

patients ? 

(A) 65 fdxzk  (A) 65 kg 

(B) 67-5 fdxzk  (B) 67.5 kg 

(C) 70 fdxzk  (C) 70 kg 

(D) 72-5 fdxzk  (D) 72.5 kg 

25. thou foKku vuqla/kku esa lkaf[;dh dh 

lhekvksa dks dSls de fd;k tk ldrk gS \ 

 25. How can the limitations of statistics be 

mitigated in life sciences research ? 

(A) MsVk laxzg ls cpdj  (A) By avoiding data collection 

(B) lkaf[;dh; =qfV;ksa dks utjvankt 

djdj 

 (B) By ignoring statistical errors 

(C) iqjkuh fof/k;ksa dk mi;ksx djdj  (C) By using outdated methods 

(D) dM+s MsVk laxzg vkSj fo'ys"k.k fof/k;ksa 

dk mi;ksx djdj 

 (D) By using rigorous data collection 

and analysis methods 

26. tSfod vuqla/kku esa lkaf[;dh; fof/k;ksa ij 

fuHkZj jgus dh ,d laHkkfor lhek D;k gS \ 

 26. What is a potential drawback of 

relying on statistical methods in 

biological research ? 

(A) ;fn mfpr :i ls fo'ys"k.k u fd;k 

tk, rks MsVk dh xyr O;k[;k gks 

ldrh gSA 

 (A) Data may be misinterpreted if 

not properly analyzed 

(B) lkaf[;dh ges'kk =qfVghu fu"d"kZ çnku 

djrh gSA 

 (B) Statistics always provide 

flawless conclusions 

(C) ;g lHkh çk;ksfxd =qfV;ksa dks lekIr 

dj nsrh gSA 

 (C) All experimental errors are 

removed through statistics 

(D) lkaf[;dh dsoy jlk;u 'kkL= esa 

mi;ksx dh tk ldrh gSA 

 (D) Statistics are limited to use in 

chemical studies only 
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27. ukWeZy forj.k dks vDlj D;k dgk tkrk gS \ 

 
27. What is a normal distribution often 

referred to as ? 

(A) f=dks.kh; oØ  (A) Triangle curve 

(B) oxZ oØ  (B) Square curve 

(C) ?kaVh oØ  (C) Bell curve 

(D) ftxtSx oØ  (D) Zigzag curve 

28. ck;ksLVSfVfLVDl esa ckbujh ifj.kkeksa dh 

ekWMfyax djus ds fy, vkerkSj ij fdl 

forj.k dk mi;ksx fd;k tkrk gS \ 

 
28. Which distribution is commonly used 

in biostatistics for modeling binary 

outcomes ? 

(A) ukWeZy forj.k  (A) Normal distribution 

(B) ckbuksfe;y forj.k  (B) Binomial distribution 

(C) Iok;lka forj.k  (C) Poisson distribution 

(D) ,Dliksusaf'k;y forj.k  (D) Exponential distribution 

29. ck;ksLVSfVfLVDl esa çkf;drk fl¼kar ls D;k 

fu/kkZfjr djus esa enn feyrh gS \ 

 
29. What does probability theory in 

biostatistics helps to determine ? 

(A) MsVk dks vklkuh ls le>us ds fy, 

n`'; :i esa çnf'kZr djuk 

 (A) To visually display data for 

easier interpretation 

(B) ,d Qwy dk jax  (B) The color of a flower 

(C) fdlh ?kVuk ds ?kfVr gksus dh laHkkouk  (C) The likelihood of an event 

occurring 

(D) fdlh oLrq dk vkdkj  (D) The shape of an object 
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30. ck;ksLVSfVfLVDl esa mi;ksx dh tkus okyh 

lkekU; xzkfQdy çLrqfr dkSu&lh gS \ 

 
30. Which of the following is a common 

graphical representation used in 

biostatistics ? 

(A) fgLVksxzke  (A) Histogram 

(B) ikbZ pkVZ  (B) Pie chart 

(C) js[kkadu  (C) Line graph 

(D) mi;qZDr lHkh  (D) All of the above 

31. ck;ksLVSfVfLVDl esa xzkfQdy çLrqrhdj.k dk 

eq[; mís'; D;k gS \ 

 
31. What is the primary purpose  

of graphical representation in 

biostatistics ? 

(A) MsVk dks n`'; :i esa çLrqr djuk rkfd 

mls vklkuh ls le>k tk lds 

 (A) To visually present data for 

easier interpretation 

(B) lkaf[;dh; x.kuk,¡ djuk  (B) To perform statistical 

calculations 

(C) ç;ksxkRed MsVk ,d= djuk  (C) To collect experimental data 

(D) MsVk dks MkVkcsl esa laxzghr djuk  (D) To store data in databases 

32. thou foKku esa ck;ksLVSfVfLVDl dk mi;ksx 

dSls fd;k tkrk gS \ 

 
32. How is biostatistics applied in life 

sciences ? 

(A) çk;ksfxd MsVk dk fo'ys"k.k djuk vkSj 

fu"d"kZ fudkyuk 

 (A) To analyze experimental data 

and draw conclusions 

(B) daI;wVj lkW¶Vos;j cukuk  (B) To build computer software 

(C) okgu fMtkbu djuk  (C) To design vehicles 

(D) iqyksa dk fuekZ.k djuk  (D) To construct bridges 
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33. ck;ksLVSfVfLVDl ds lanHkZ esa] lkj.khdj.k D;k 

gS \ 

 
33. What is tabulation in the context of 

biostatistics ? 

(A) MsVk dks rkfydkvksa esa O;ofLFkr djuk 

rkfd mls vklkuh ls le>k tk lds 

 (A) Arranging data in tables for easy 

interpretation 

(B) miU;kl fy[kuk  (B) Writing novels 

(C) laxhr jpuk  (C) Composing music 

(D) diM+s fMtkbu djuk  (D) Designing clothing 

34. ck;ksLVSfVfLVDl esa oxhZdj.k 

(Classification) dk D;k vFkZ gS \ 

 
34. In biostatistics, classification refers to : 

(A) ç;ksx'kkyk esa uewuksa dk HkkSfrd 

oxhZdj.k 

 (A) Physical categorization of 

samples in a laboratory 

(B) fo'ys"k.k ds fy, MsVk dks lkFkZd oxks± 

;k lewgksa esa O;ofLFkr djuk 

 (B) Arrangement of data into 

meaningful groups or classes for 

analysis 

(C) pj dk xzkfQdy çLrqrhdj.k  (C) Graphical representation of 

variables 

(D) ifjdYiuk dk lkaf[;dh; ijh{k.k  (D) Statistical testing of hypotheses 

35. ck;ksLVSfVfLVDl esa MsVk dEikbys'ku dk D;k 

vFkZ gS \ 

 
35. Data compilation in biostatistics refers 

to : 

(A) fo'ys"k.k ds fy, MsVk dk laxzg vkSj 

laxBu 

 (A) Collecting and organizing data 

for analysis 

(B) lkaf[;dh; ijh{k.k djuk  (B) Performing statistical tests 

(C) ifj.kkeksa dh O;k[;k djuk  (C) Interpreting experimental results 

(D) MsVk dk xzkfQdy çLrqrhdj.k  (D) Presenting data graphically 
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36. fuEufyf[kr esa ls dkSu&lh fof/k 

ck;ksLVSfVfLVDl esa pj ds chp laca/kksa ds 

fo'ys"k.k ds fy, lkekU;r% mi;ksx dh tkrh 

gS \ 

 
36. Which of the following is a commonly 

used statistical method in biostatistics 

for analyzing relationships between 

variables ? 

(A) çfrxeu ;k izrhixeu fo'ys"k.k   (A) Regression analysis 

(B) ØkseSVksxzkfQd i`FkDdj.k  (B) Chromatographic separation 

(C) Mh,u, vuqØe.k  (C) DNA sequencing 

(D) best çkslsflax  (D) Image processing 

37. ck;ksLVSfVfLVDl dh ifjHkk"kk D;k gS \ 

 
37. What is the definition of biostatistics ? 

(A) foÙkh; cktkjksa dk fo'ys"k.k  (A) The analysis of financial markets 

(B) ikni thofoKku dk v/;;u  (B) The study of plant biology 

(C) tSfod vkSj LokLF; foKku esa 

lkaf[;dh dk vuqç;ksx 

 (C) The application of statistics to 

biological and health sciences 

(D) i;kZoj.k foKku dk v/;;u  (D) The study of environmental 

sciences 

38. ck;ksbUQkWesZfVDl esa MSA dk D;k vFkZ gS \ 

 
38. In bioinformatics, what does MSA 

stand for ? 

(A) ,dkf/kd vuqØe lajs[k.k  (A) Multiple Sequence Alignment 

(B) vk.kfod lajpukRed fo'ys"k.k  (B) Molecular Structural Analysis 

(C) fpfdRlk lkaf[;dh; fo'ys"k.k  (C) Medical Statistical Analysis 

(D) ekbØksfc;y lSaiy ,ukfyfll  (D) Microbial Sample Analysis 
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39. ,dkf/kd vuqØe lajs[k.k D;k gS \ 

 
39. What is multiple sequence alignment ? 

(A) ,d lkFk dbZ Nfo;ksa dks laikfnr 

djuk 

 (A) Editing multiple images 

simultaneously 

(B) ,d vuqØe dks 3Mh ekWMy ds lkFk 

lajsf[kr djuk 

 (B) Aligning one sequence with a 

3D model 

(C) nks ls vf/kd vuqØeksa dks lajsf[kr 

djuk vkSj lekurk ds {ks=ksa dh igpku 

djuk 

 (C) Aligning more than two 

sequences to identify regions of 

similarity 

(D) jklk;fud lw=ksa dks lajsf[kr djuk  (D) Aligning chemical formulas 

40. Needleman-Wunsch ,YxksfjFe dk mi;ksx 

fdlds fy, fd;k tkrk gS \ 

 
40. Needleman-Wunsch algorithm is used 

for : 

(A) yksdy vuqØe lajs[k.k  (A) Local sequence alignment 

(B) MkVkcsl [kkst  (B) Database searching 

(C) cgq&vuqØe lajs[k.k  (C) Multiple sequence alignment 

(D) tSfod vuqØeksa dk oSf'od lajs[k.k  (D) Global alignment of biological 

sequences 

41. is;jokbt vuqØe lajs[k.k dk mi;ksx fdl 

fy, fd;k tkrk gS \ 

 
41. What is pair-wise sequence alignment 

used for ? 

(A) 3Mh ekWMy cukuk  (A) Creating 3D models 

(B) nks vuqØeksa dh rqyuk djds lekurk 

ds {ks=ksa dh igpku djuk 

 (B) Comparing two sequences to 

identify regions of similarity 

(C) vkuqoaf'kd lkexzh laikfnr djuk  (C) Editing genetic material 

(D) jklk;fud çfrfØ;k,¡ djuk  (D) Conducting chemical reactions 
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42. ck;ksbUQkWesZfVDl esa lekurk [kkst dk eq[; 

mís'; D;k gS \ 

 
42. What is the main purpose of similarity 

searching in bioinformatics ? 

(A) MsVkcsl esa leku vuqØeksa dks [kkstuk  (A) To find similar sequences in a 

database 

(B) tSfod Nfo;ksa dks laikfnr djuk  (B) To edit biological images 

(C) xf.krh; ekWMy cukuk  (C) To create mathematical models 

(D) foÙkh; MsVk laxzghr djuk  (D) To store financial data 

43. ck;ksbUQkWesZfVDl esa ClustalW dk eq[; dk;Z 

D;k gS \ 

 
43. What is the primary function of 

ClustalW in bioinformatics ? 

(A) Mh,u, ;k çksVhu vuqØeksa dk 

cgq&vuqØe lajs[k.k 

 (A) Multiple sequence alignment of 

DNA or protein sequences 

(B) vuqØeksa dks MkVkcsl esa tek djuk  (B) Sequence submission to 

databases 

(C) thukse ,uksVs'ku  (C) Genome annotation 

(D) çksVhu lajpuk dh Hkfo";ok.kh  (D) Protein structure prediction 

44. çksVhu vuqØe.k ds fy, vkerkSj ij fdl 

fof/k dk mi;ksx fd;k tkrk gS \ 

 
44. Which method is commonly used for 

protein sequencing ? 

(A) tsy bysDVªksQksjsfll  (A) Gel electrophoresis 

(B) ihlhvkj  (B) PCR 

(C) ,MeSu fMxzsMs'ku  (C) Edman degradation 

(D) lkmnuZ CykWfVax  (D) Southern blotting 
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45. çksVhu vuqØe.k dk eq[; mís'; D;k gS \ 

 
45. What is the primary goal of protein 

sequencing ? 

(A) ,d çksVhu esa ,feuks ,flM~l ds Øe 

dks fu/kkZfjr djuk 

 (A) To determine the sequence of 

amino acids in a protein 

(B) ,d fMftVy Nfo cukuk  (B) To create a digital image 

(C) ,d ?kksy dk ih,p ekiuk  (C) To measure the pH of a solution 

(D) vkuqokaf'kd lkexzh dks laikfnr djuk  (D) To edit genetic material 

46. mPp&FkzwiqV thu vuqØe.k ds fy, vkerkSj 

ij fdl rduhd dk mi;ksx fd;k tkrk gS \ 

 
46. Which technology is commonly used 

for high-throughput gene sequencing ? 

(A) lSaxj lhDosaflax  (A) Sanger sequencing 

(B) ,uth,l  (B) NGS 

(C) ukWnZuZ CykWfVax  (C) Northern blotting 

(D) osLVuZ CykWfVax  (D) Western blotting 

47. vk.kfod thofoKku esa thu vuqØe.k  

(gene sequencing) dk eq[; mís'; D;k  

gS \ 

 
47. What is the primary objective of gene 

sequencing in molecular biology ? 

(A) fMftVy fp=ksa dk laiknu  (A) Editing digital images 

(B) Mh,u, vuqØe esa U;wfDy;ksVkbM~l ds 

lVhd Øe dk fu/kkZj.k 

 (B) Determining the precise order of 

nucleotides in a DNA sequence 

(C) çksVhu dh ek=k ekiuk  (C) Measuring protein concentration 

(D) oa'kkoyh o`{k (phylogenetic tree) 

cukuk 

 (D) Constructing phylogenetic trees 



 

B170602T ( 17 )  Set-C 

48. fuEufyf[kr esa ls dkSu&lk Vwy MsVkcsl ls 

tSfod vuqØeksa dks iqu% çkIr djus ds fy, 

vkerkSj ij mi;ksx fd;k tkrk gS \ 

 
48. Which of the following tools is 

commonly used for retrieving 

biological sequences from databases ? 

(A) eSVySc  (A) MATLAB 

(B) ,Mksc QksVks'kkWi  (B) Adobe Photoshop 

(C) CykLV  (C) BLAST 

(D) ,lvkj,l  (D) SRS 

49. ck;ksbUQkWesZfVDl MkVkcsl esa Entrez ç.kkyh 

dh eq[; Hkwfedk D;k gS \ 

 
49. What is the primary role of the Entrez 

system in bioinformatics databases ? 

(A) vuqØe lajs[k.k djuk  (A) Performing sequence alignment 

(B) MkVkcsl ls tSfod tkudkjh [kkstuk 

vkSj çkIr djuk 

 (B) Searching and retrieving 

biological data from databases 

(C) best çkslsflax djuk  (C) Processing images 

(D) lkaf[;dh; x.kuk djuk  (D) Performing statistical compu-

tations 

50. BLAST dk iwjk uke D;k gS \ 

 
50. What does BLAST stand for ? 

(A) ck;ksesfVªd yksds'ku vYxksfjFke 

flLVe Vwy 

 (A) Biometric Location Algorithm 

System Tool 

(B) ck;ksykWftdy ySc ,ukfyfll 

lkW¶Vos;j VsDuhd 

 (B) Biological Lab Analysis 

Software Technique 

(C) csfld yksdy vykbuesaV lpZ Vwy  (C) Basic Local Alignment Search 

Tool 

(D) ck;ksbUQkWesZfVDl ykWftdy ,js lpZ 

Vwy 

 (D) Bioinformatics Logical Array 

Search Tool 
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51. NCBI dk iwjk uke D;k gS \ 

 
51. What is the full form of NCBI ? 

(A) us'kuy lsaVj QkWj ck;ksVsDuksykWth 

buQkesZ'ku 

 (A) National Center for 

Biotechnology Information 

(B) us'kuy dkmafly QkWj ck;ksykWftdy 

baVhxzs'ku 

 (B) National Council for Biological 

Integration 

(C) us'kuy lsaVj QkWj ck;ksbUQkWesZfVDl ,aM 

buksos'ku 

 (C) National Center for 

Bioinformatics and Innovation 

(D) us'kuy desVh QkWj ck;ksbUQkWesZfVDl  (D) National Committee for 

Bioinformatics 

52. dsbZthth MsVkcsl dk eq[; mi;ksx D;k gS \ 

 
52. What is the main use of the KEGG 

database ? 

(A) foÙkh; MsVk laxzghr djuk  (A) Storing financial data 

(B) esVkcksfyd ikFkos vkSj baVjsD'ku dk 

fo'ys"k.k djuk 

 (B) Analyzing metabolic pathways 

and interactions 

(C) xzkfQDl fMtkbu djuk  (C) Designing graphics 

(D) lkaf[;dh; fo'ys"k.k djuk  (D) Conducting statistical analysis 

53. thukse ,uksVs'ku ds fy, vkerkSj ij fdl 

Vwy dk mi;ksx fd;k tkrk gS \ 

 
53. Which tool is commonly used for 

genome annotation ? 

(A) vkVsZfel  (A) Artemis 

(B) ,Mksc QksVks'kkWi  (B) Adobe Photoshop 

(C) vkWVksdSM  (C) AutoCAD 

(D) ,Dlsy  (D) Excel 
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54. çksVhu lajpukvksa dks ns[kus ds fy, fdl 

ck;ksbUQkWesZfVDl Vwy dk mi;ksx fd;k tkrk 

gS \ 

 
54. Which bioinformatics tool is used to 

visualize protein structures ? 

(A) esxk  (A) MEGA 

(B) CykLV  (B) BLAST 

(C) ik;eksy  (C) PyMOL 

(D) DyLVyMCY;w  (D) ClustalW 

55. fuEufyf[kr esa ls fdl Vwy dk mi;ksx 

,dkf/kd vuqØe lajs[k.k ds fy, fd;k tkrk 

gS \ 

 55. Which of the following tools is used 

for multiple sequence alignment ? 

(A) DyLVy vksesxk  (A) Clustal Omega 

(B) ,e,l oMZ  (B) MS Word 

(C) eSVySc  (C) MATLAB 

(D) ,lih,l,l  (D) SPSS 

56. ck;ksbUQkWesZfVDl esa BLAST Vwy dk eq[; 

dk;Z D;k gS \ 

 56. What is the primary function of the 

BLAST tool in bioinformatics ? 

(A) vuqØe lajs[k.k vkSj lekurk [kkst  (A) Sequence alignment and 

similarity search 

(B) best laiknu  (B) Image editing 

(C) LçsM'khV x.kuk  (C) Spreadsheet calculation 

(D) MsVkcsl çca/ku  (D) Database management 
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57. dkSu&lk lkW¶Vos;j O;kid :i ls 

Q+kbykstsusfVd isM+ cukus ds fy, mi;ksx 

fd;k tkrk gS \ 

 57. Which software is widely used for 

constructing phylogenetic trees ? 

(A) DyLVyMCY;w  (A) ClustalW 

(B) esxk  (B) MEGA 

(C) CykLV  (C) BLAST 

(D) jkleksy  (D) RASMOL 

58. vuqØe lajs[k.k ds fy, fuEufyf[kr esa ls 

dkSu&lk midj.k vkerkSj ij mi;ksx fd;k 

tkrk gS \ 

 58. Which of the following is a commonly 

used tool for sequence alignment ? 

(A) CykLV  (A) BLAST 

(B) ,Dlsy  (B) Excel 

(C) QksVks'kkWi  (C) Photoshop 

(D) vkWVksdSM  (D) AutoCAD 

59. dkSu&lk MsVkcsl fo'ks"k :i ls çksVhu 

lajpukvksa dks laxzghr djus ds fy, fMtkbu 

fd;k x;k gS \ 

 59. Which database is specifically 

designed for storing protein  

structures ? 

(A) tsucSad  (A) GenBank 

(B) ihMhch (çksVhu MsVk cSad)  (B) PDB (Protein Data Bank)  

(C) dsbZthth  (C) KEGG 

(D) ;wfuthu  (D) UniGene 
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60. dkSu&lk MsVkcsl fofHkUu lzksrksa ls tkudkjh 

dks ,dhÏr dj çksVhu ifjokjksa ds dk;kZRed 

fo'ys"k.k dh lqfo/kk nsrk gS \ 

 60. Which database integrates information 

from multiple sources to provide 

functional analysis of protein  

families ? 

(A) çkslkbV (Prosite)  (A) Prosite 

(B) tsucSad (GenBank)  (B) GenBank 

(C) ihMhch (PDB)  (C) PDB 

(D) dsx (KEGG)  (D) KEGG 

61. çkFkfed vkSj f}rh;d MsVkcsl ls ,d lexz 

MsVkcsl dks D;k vyx djrk gS \ 

 
61. What distinguishes a composite 

database from primary and secondary 

database ? 

(A) ;g dsoy foÙkh; MsVk laxzghr djrk 

gSA 

 (A) It stores only financial data. 

(B) ;g dbZ lzksrksa ls MsVk dks tksM+rk gSA  (B) It combines data from multiple 

sources. 

(C) ;g ohfM;ks laiknu ds fy, mi;ksx 

fd;k tkrk gSA 

 (C) It is used for video editing. 

(D) blesa tSfod MsVk ugha gksrkA  (D) It does not contain biological 

data. 

62. fuEufyf[kr esa ls dkSu ,d f}rh;d tSfod 

MsVkcsl gS \ 

 
62. Which of the following is a secondary 

biological database ? 

(A) ,ulhchvkbZ  (A) NCBI 

(B) bZ,ech,y  (B) EMBL 

(C) ihMhch  (C) PDB 

(D) ;wfuçksV  (D) UniProt 
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63. ,d f}rh;d MsVkcsl esa vkerkSj ij fdl 

çdkj dh tkudkjh laxzghr gksrh gS \ 

 
63. What type of information is typically 

stored in a secondary database ? 

(A) dPpk vuqØe MsVk  (A) Raw sequence data 

(B) çkFkfed MsVk dh O;k[;k,¡ vkSj 

fVIif.k;k¡ 

 (B) Annotations and interpretations 

of primary data 

(C) foÙkh; MsVk  (C) Financial data 

(D) eYVhehfM;k QkbYl  (D) Multimedia files 

64. çkFkfed MsVkcsl eq[; :i ls fdl çdkj ds 

MsVk dks laxzghr djus ds fy, ftEesnkj gksrs  

gSa \ 

 
64. Primary databases are mainly 

responsible for storing which type of 

data ? 

(A) fo'ysf"kr MsVk  (A) Analyzed data 

(B) xf.krh; ekWMYl  (B) Mathematical models 

(C) lkW¶Vos;j dksM  (C) Software code 

(D) dPpk ç;ksxkRed MsVk  (D) Raw experimental data 

65. fuEufyf[kr esa ls dkSu ,d çkFkfed tSfod 

MsVkcsl dk mnkgj.k gS \ 

 
65. Which of the following is an example 

of a primary biological database ? 

(A) fLol&çksV  (A) Swiss-Prot 

(B) tsucSad  (B) GenBank 

(C) çks&lkbV  (C) Prosite 

(D) dsbZthth  (D) KEGG 
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66. tSfod MsVkcsl dk eq[; mís'; D;k gS \ 

 
66. What is the main purpose of a 

biological database ? 

(A) foÙkh; fjdkWMZ~l dks laxzghr djuk  (A) Storing financial records 

(B) tSfod MsVk dks laxzghr djuk vkSj 

O;ofLFkr djuk 

 (B) Storing and organizing 

biological data 

(C) lkW¶Vos;j vuqç;ksxksa dk fodkl  (C) Developing software appli-

cations 

(D) eYVhehfM;k lkexzh cukuk  (D) Creating multimedia content 

67. fuEufyf[kr esa ls dkSu&lk ck;ksbUQkWesZfVDl 

ykbczsjh Python esa fodflr gS vkSj vuqØe 

fo'ys"k.k rFkk tSfod MsVk çkslsflax ds fy, 

mi;ksx gksrk gS \ 

 
67. Which of the following is a widely used 

bioinformatics library implemented in 

Python for sequence analysis and 

biological data processing ? 

(A) BioPerl  (A) BioPerl 

(B) BioJava  (B) BioJava 

(C) BioR  (C) BioR 

(D) Bio Python  (D) BioPython 

68. ck;ksbUQkWesZfVDl esa fLØfIVax vkSj VsDLV 

çkslsflax ds fy, fdl Hkk"kk dk mi;ksx fd;k 

tkrk gS \ 

 
68. Which language is known for its use in 

scripting and text processing in 

bioinformatics ? 

(A) iyZ  (A) Perl 

(B) dkscksy  (B) COBOL 

(C) QksVªkZu  (C) FORTRAN 

(D) ,lD;w,y  (D) SQL 
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69. ck;ksbUQkWesZfVDl esa osc&vk/kkfjr vuqç;ksxksa 

dks fodflr djus ds fy, vkerkSj ij 

dkSu&lh Hkk"kk mi;ksx dh tkrh gS \ 

 
69. In bioinformatics, which language is 

commonly used for developing web-

based applications ? 

(A) :ch  (A) Ruby 

(B) iyZ  (B) Perl 

(C) tkok  (C) Java 

(D) ih,pih  (D) PHP 

70. ck;ksbUQkWesZfVDl esa MsVk eSfuiqys'ku vkSj 

fo'ys"k.k ds fy, fuEufyf[kr esa ls dkSu&lh 

çksxzkfeax Hkk"kk O;kid :i ls mi;ksx dh 

tkrh gS \ 

 
70. Which of the following programming 

languages is known for its extensive 

use In bioinformatics for data 

manipulation and analysis ? 

(A) tkokfLØIV  (A) JavaScript 

(B) ik;Fku  (B) Python 

(C) HTML  (C) HTML 

(D) fLo¶V  (D) Swift 

71. ck;ksbUQkWesZfVDl esa lkaf[;dh; x.kuk vkSj 

MsVk fo'ys"k.k ds fy, dkSu&lh çksxzkfeax 

Hkk"kk lcls vf/kd mi;ksx dh tkrh gS \ 

 
71. Which programming language is most 

widely used for statistical computing 

and data analysis in bioinformatics ? 

(A) Python  (A) Python 

(B) Java  (B) Java 

(C) C++  (C) C++ 

(D) R  (D) R 
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72. fuEufyf[kr esa ls dkSu&lh rduhd vkerkSj 

ij esVkcksyksfeDl esa NksVs v.kq esVkcksykbV~l dk 

v/;;u djus ds fy, mi;ksx dh tkrh gS \ 

 
72. Which of the following techniques is 

commonly applied to study  

small-molecule metabolites in 

metabolomics ? 

(A) U;wfDy;j eSXusfVd jstksusal (NMR) 

LisDVªksLdksih 

 (A) Nuclear Magnetic Resonance 

(NMR) Spectroscopy 

(B) ikWyhejst psu fj,D'ku (PCR)  (B) Polymerase Chain Reaction 

(PCR)  

(C) ,fylk  (C) ELISA 

(D) osLVuZ CykWV  (D) Western Blot 

73. esVkcksyksfeDl fuEufyf[kr esa ls fdldk 

v/;;u djrk gS \ 

 
73. Metabolomics is concerned with the 

study of which of the following ? 

(A) thoksa esa fyfiM çksQkbYl  (A) Lipid profiles in organisms 

(B) dksf'kdkvksa esa esVkcksykbV~l  (B) Metabolites within cells 

(C) çksVhu baVjSD'kUl  (C) Protein interactions 

(D) tsusfVd E;wVs'ku  (D) Genetic mutations 

74. çksVhvksfeDl esa lSaiy esa çksVhUl dh igpku 

djus ds fy, vkerkSj ij fdl fof/k dk 

mi;ksx fd;k tkrk gS \ 

 
74. Which method is commonly used in 

proteomics to identify proteins in a 

sample ? 

(A) tsy bysDVªksQksjsfll  (A) Gel electrophoresis 

(B) ØkseSVksxzkQh  (B) Chromatography 

(C) ekl LisDVªksesVªh  (C) Mass spectrometry 

(D) LisDVªksQksVksesVªh  (D) Spectrophotometry 
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75. çksVhvksfeDl fdldk cM+s iSekus ij v/;;u 

gS \ 

 
75. Proteomics is the large-scale study of 

what ? 

(A) fyfiM~l  (A) Lipids 

(B) dkcksZgkbMªsV~l  (B) Carbohydrates 

(C) U;wfDyd ,flM~l  (C) Nucleic acids 

(D) çksVhUl  (D) Proteins 

76. thu vfHkO;fä dks ekius ds fy, 

VªkalfØIVksfeDl esa vDlj fdl rduhd dk 

mi;ksx fd;k tkrk gS \ 

 
76. Which technique is often used in 

transcriptomics to measure gene 

expression ? 

(A) osLVuZ CykWfVax  (A) Western blotting 

(B) ekl LisDVªksesVªh  (B) Mass spectrometry 

(C) vkj,u, lhDosaflax (RNA-seq)  (C) RNA sequencing (RNA-seq)  

(D) ELISA  (D) ELISA 

77. VªkalfØIVksfeDl fuEufyf[kr esa ls fdldk 

v/;;u djrk gS \ 

 
77. Transcriptomics focuses on the study 

of which of the following ? 

(A) çksVhu vkSj mudh lajpuk,¡  (A) Proteins and their structures 

(B) vkj,u, VªkalfØIV~l  (B) RNA transcripts 

(C) dksf'kdkvksa esa esVkcksykbV~l  (C) Metabolites in cells 

(D) fyfiM la'ys"k.k  (D) Lipid synthesis 
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78. thuksfeDl esa vkerkSj ij fdl rduhd dk 

mi;ksx fd;k tkrk gS \ 

 
78. Which of the following technologies is 

commonly used in genomics ? 

(A) ,Dl&js fØLVyksxzkQh  (A) X-ray crystallography 

(B) usDLV tsujs'ku lhDosaflax (NGS)  (B) Next-generation sequencing 

(NGS)  

(C) iksyhejst+ psu fj,D'ku (PCR)  (C) Polymerase chain reaction 

(PCR)  

(D) bysDVªkWu ekbØksLdksih  (D) Electron microscopy 

79. thuksfeDl dk {ks= fdldk v/;;u djrk  

gS \ 

 
79. What does the field of genomics  

study ? 

(A) thukse dh lajpuk vkSj dk;Z  (A) The structure and function of 

genomes 

(B) jklk;fud çfrfØ;kvksa esa v.kqvksa dk 

O;ogkj 

 (B) The behavior of molecules in 

chemical reactions 

(C) lkexzh ds HkkSfrd xq.k  (C) The physical properties of 

materials 

(D) ikS/kksa dh 'kkjhfjd jpuk  (D) The anatomy of plants 

80. fuEufyf[kr esa ls dkSu&lk ;a= fMftVy 

ladsrksa dks ,ukykWx ladsrksa esa ifjofrZr djrk 

gS \ 

 
80. Which of the following devices 

converts digital signals to analog 

signals ? 

(A) ekWMse  (A) Modem 

(B) ekml  (B) Mouse 

(C) ,l,lMh  (C) SSD 

(D) fçaVj  (D) Printer 
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81. Microsoft Word fdl çdkj ds lkW¶Vos;j 

dk mnkgj.k gS \ 

 
81. Microsoft Word is an example of 

which type of software ? 

(A) vkWijsfVax flLVe lkW¶Vos;j  (A) Operating system software 

(B) ,fIyds'ku lkW¶Vos;j  (B) Application software 

(C) QeZos;j  (C) Firmware 

(D) flLVe ;wfVfyVh  (D) System utility 

82. fuEufyf[kr esa ls dkSu vkWfIVdy LVksjst 

ehfM;k dk mnkgj.k gS \ 

 
82. Which of the following is an example 

of optical storage media ? 

(A) ;w,lch ¶yS'k Mªkbo  (A) USB Flash Drive 

(B) MhohMh  (B) DVD 

(C) ,l,lMh  (C) SSD 

(D) ¶ykWih fMLd  (D) Floppy Disk 

83. daI;wVj 'kCnkoyh esa RAM dk iwjk uke D;k 

gS \ 

 
83. What does RAM stand for in computer 

terminology ? 

(A) jSaMe ,Dlsl eseksjh  (A) Random Access Memory 

(B) jhM ,Dlsl eseksjh  (B) Read Access Memory 

(C) jSfiM ,Dlsl eseksjh  (C) Rapid Access Memory 

(D) fj;y&Vkbe ,Dlsl eseksjh  (D) Real-time Access Memory 
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84. Excel esa "SUM" QaD'ku D;k djrk gS \ 

 
84. What does the “SUM” function in 

Excel do ? 

(A) lsYl dh la[;k fxurk gSA  (A) Counts the number of cells 

(B) lsYl dh ,d Js.kh esa ewY;ksa dks 

tksM+rk gSA 

 (B) Adds up the values in a range of 

cells 

(C) Js.kh esa lcls NksVk ewY; ikrk gSA  (C) Finds the smallest value in a 

range 

(D) Js.kh esa lcls cM+k ewY; ikrk gSA  (D) Finds the largest value in a range 

85. Excel esa Combo Chart dk mi;ksx fdlds 

fy, fd;k tkrk gS \ 

 
85. Combo Chart in Excel is used for : 

(A) ,d gh pkVZ esa fofHkUu çdkj ds pkVZ 

çnf'kZr djuk 

 (A) Displaying multiple chart types 

within a single chart 

(B) nks pjksa ds chp laca/k fn[kkuk  (B) Plotting relationships between 

two variables 

(C) MsVk dks LraHkksa (columns) ds :i esa 

n'kkZuk 

 (C) Representing data using vertical 

bars 

(D) vuqikrksa dks o`Ùkkdkj :i esa fn[kkuk  (D) Showing proportions in a 

circular form 
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86. Excel esa fdlh lsy esa MsVk Vkbi djus ds 

ckn ß,aVjÞ dqath nckus ij D;k gksrk gS \ 

 
86. What happens when you press the 

“Enter” key after typing data into a 

cell in Excel ? 

(A) lsy lfØ; jgrk gSA  (A) The cell remains active. 

(B) lfØ; lsy vxys dkWye esa pyk tkrk 

gSA 

 (B) The active cell moves to the next 

column. 

(C) lfØ; lsy vxyh iafä esa pyk tkrk 

gSA 

 (C) The active cell moves to the next 

row. 

(D) lfØ; lsy lkexzh dks gVk nsrk gSA  (D) The active cell deletes the 

content. 

87. fuEufyf[kr esa ls dkSu f}rh;d LVksjst 

midj.k dk çdkj gS \ 

 
87. Which of the following is a type of 

secondary storage device ? 

(A) jSe  (A) RAM 

(B) jkse  (B) ROM 

(C) gkMZ fMLd  (C) Hard Disk 

(D) lhih;w  (D) CPU 

88. fuEufyf[kr esa ls dkSu ,d ,ukykWx&Vw& 

fMftVy :ikarj.k midj.k dk mnkgj.k gS \ 

 
88. Which of the following is an example 

of an analog-to-digital conversion 

device ? 

(A) ekbØksQksu  (A) Microphone 

(B) Lihdj  (B) Speaker 

(C) ekWfuVj  (C) Monitor 

(D) fçaVj  (D) Printer 
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89. Excel esa ekuksa dh ,d Js.kh dk vkSlr 

fudkyus ds fy, dkSu&lk QaD'ku mi;ksx 

fd;k tkrk gS \ 

 
89. Which Excel function is used to 

calculate the average of a range of 

values ? 

(A) SUM  (A) SUM 

(B) COUNT  (B) COUNT 

(C) AVERAGE  (C) AVERAGE 

(D) MAX  (D) MAX 

90. Excel esa Scatter Chart dk eq[; mi;ksx 

fdlds fy, fd;k tkrk gS \ 

 
90. Scatter Chart in Excel is primarily 

used for : 

(A) Jsf.k;ksa ds vuqikr dks fn[kkuk  (A) Displaying proportions of 

categories 

(B) le; ds lkFk #>ku fn[kkuk  (B) Showing trends over time 

(C) vyx&vyx Jsf.k;ksa dh rqyuk djuk  (C) Comparing discrete categories 

(D) nks ek=kRed pjksa ds chp laca/k dk 

fo'ys"k.k djuk 

 (D) Analyzing the relationship 

between two quantitative 

variables 

91. Excel esa lsy dh lkexzh dks laikfnr djus 

ds fy, fuEufyf[kr esa ls dkSu&lk 'kkWVZdV 

mi;ksx fd;k tkrk gS \ 

 
91. Which of the following shortcuts is 

used to edit the content of a cell in 

Excel ? 

(A) F2  (A) F2 

(B) F4  (B) F4 

(C) F7  (C) F7 

(D) F10  (D) F10 
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92. fdl çdkj dh eseksjh ukWu&oksysVkby gksrh gS 

vkSj nh?kZdkfyd MsVk LVksjst ds fy, mi;ksx 

dh tkrh gS \ 

 
92. Which type of memory is non- 

volatile and is used for long-term data 

storage ? 

(A) jSe  (A) RAM 

(B) jkse  (B) ROM 

(C) dS'ks eseksjh  (C) Cache Memory 

(D) gkMZ fMLd  (D) Hard Disk 

93. daI;wVj dh fdl ih<+h esa baVhxzsVsM lfdZV~l 

(ICs) dk mi;ksx 'kq: gqvk \ 

 
93. Which generation of computers 

introduced the use of integrated 

circuits (ICs) ? 

(A) igyh ih<+h  (A) First Generation 

(B) nwljh ih<+h  (B) Second Generation 

(C) rhljh ih<+h  (C) Third Generation 

(D) pkSFkh ih<+h  (D) Fourth Generation 

94. dkSu&lk daI;wVj O;fäxr dk;ks± tSls baVjusV 

czkmftax vkSj oMZ çkslsflax ds fy, mi;ksx 

fd;k tkrk gS \ 

 
94. Which type of computer is used for 

personal tasks such as browsing the 

internet and word processing ? 

(A) esuÝse  (A) Mainframe 

(B) lqijdaI;wVj  (B) Supercomputer 

(C) ilZuy daI;wVj  (C) Personal Computer 

(D) feuhdaI;wVj  (D) Minicomputer 
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95. daI;wVj flLVe esa gkMZ fMLd Mªkbo (HDD) 

dk eq[; dk;Z D;k gS \ 

 
95. The primary function of a hard disk 

drive (HDD) in a computer system is 

to : 

(A) MsVk çkslsflax vkSj x.kuk djuk  (A) Perform data processing and 

calculations 

(B) nh?kZdkfyd (ukWu&oksysVkby) MsVk 

LVksjst çnku djuk 

 (B) Provide long-term (non-volatile) 

data storage 

(C) çksxzke pykus ds fy, vLFkk;h eseksjh 

çnku djuk 

 (C) Offer temporary memory for 

executing programs 

(D) ckgjh buiqV@vkmViqV midj.kksa ls 

baVjQsl djuk 

 (D) Interface with external 

input/output devices 

96. lsaVªy çkslsflax ;wfuV (CPU) dks ekuk tkrk  

gS % 

 
96. Central Processing Unit (CPU) is 

considered as : 

(A) fMftVy daI;wVj  (A) Digital computer 

(B) ,ukykWx daI;wVj  (B) Analogue computer 

(C) daI;wVj dk efLr"d  (C) Brain of computer 

(D) ikoj lIykbZ  (D) Power supply 

97. daI;wVj esa vkWijsfVax flLVe (OS) dk eq[; 

dk;Z D;k gS \ 

 
97. The operating system (OS) in a 

computer primarily functions to : 

(A) flLVe ds gkMZos;j vkSj lkW¶Vos;j 

lalk/kuksa dk çca/ku djuk 

 (A) Manage hardware and software 

resources of the system 

(B) ,aVhok;jl lqj{kk çnku djuk  (B) Provide antivirus protection 

(C) nLrkost vkSj LçsM'khV cukuk  (C) Create documents and 

spreadsheets 

(D) baVjusV dusfDVfoVh LFkkfir djuk  (D) Establish internet connectivity 
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98. fuEufyf[kr esa ls dkSu&lk buiqV fMokbl dk 

mnkgj.k gS \ 

 
98. Which of the following is an example 

of an input device ? 

(A) fçaVj  (A) Printer 

(B) ekWfuVj  (B) Monitor 

(C) dhcksMZ  (C) Keyboard 

(D) Lihdj  (D) Speaker 

99. fuEufyf[kr esa ls dkSu&lk tSfod vuqla/kku 

esa ck;ksbUQkWesZfVDl dk çeq[k vuqç;ksx gS \ 

 
99. Which of the following represents a 

major application of bioinformatics in 

biological research ? 

(A) ubZ çksxzkfeax Hkk"kkvksa dk fodkl  (A) Developing new programming 

languages 

(B) çksVhu lajpuk vkSj dk;Z dh 

Hkfo";ok.kh 

 (B) Predicting protein structure and 

function 

(C) ;kaf=d midj.kksa dk fuekZ.k  (C) Designing mechanical devices 

(D) fMftVy bysDVªkWfud lfdZV cukuk  (D) Building digital electronic 

circuits 

100. thofoKku esa ck;ksbUQkWesZfVDl dk eq[; 

mi;ksx fdlds fy, fd;k tkrk gS \ 

 
100. Bioinformatics is primarily applied in 

biology for : 

(A) HkkSfrd fu;eksa dk v/;;u  (A) Studying physical laws 

(B) tSfod MsVk vkSj tkudkjh dk 

fo'ys"k.k ,oa O;k[;k 

 (B) Analyzing and interpreting 

biological data and information 

(C) foÙkh; vfHkys[kksa dk çca/ku  (C) Managing financial records 

(D) vkS|ksfxd jklk;fud ;kSfxdksa dk 

fuekZ.k 

 (D) Designing industrial chemical 

compounds 
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4. Four alternative answers are mentioned for 

each question as—A, B, C & D in the 

booklet. The candidate has to choose the  

correct answer and mark the same in the 

OMR Answer-Sheet as per the direction : 

 4. iz'u&iqfLrdk esa izR;sd iz'u ds pkj lEHkkfor 

mÙkjµA, B, C ,oa D gSaA ijh{kkFkhZ dks mu pkjksa 

fodYiksa esa ls lgh mÙkj Nk¡Vuk gSA mÙkj dks OMR 

vkUlj&'khV esa lEcfU/kr iz'u la[;k esa fuEu izdkj 

Hkjuk gS % 

Example :  
mnkgj.k % 

Question :  
iz'u % 

Q. 1  iz'u 1 

Q. 2  iz'u 2 

Q. 3  iz'u 3 

Illegible answers with cutting and  

over-writing or half filled circle will be 

cancelled. 

 viBuh; mÙkj ;k ,sls mÙkj ftUgsa dkVk ;k cnyk x;k 

gS] ;k xksys esa vk/kk Hkjdj fn;k x;k] mUgsa fujLr dj 

fn;k tk,xkA 

5. Each question carries equal marks. Marks 
will be awarded according to the number of 
correct answers you have. 

 5. izR;sd iz'u ds vad leku gSaA vkids ftrus mÙkj lgh 

gksaxs] mUgha ds vuqlkj vad iznku fd;s tk;saxsA 

6. All answers are to be given on OMR 
Answer Sheet only. Answers given 
anywhere other than the place specified in 
the answer sheet will not be considered 
valid. 

 6. lHkh mÙkj dsoy vks- ,e- vkj- mÙkj&i=d (OMR 

Answer Sheet) ij gh fn;s tkus gSaA mÙkj&i=d esa 

fu/kkZfjr LFkku ds vykok vU;= dgha ij fn;k x;k 

mÙkj ekU; ugha gksxkA 

7. Before writing anything on the OMR 
Answer Sheet, all the instructions given in it 
should be read carefully.  

 7. vks- ,e- vkj- mÙkj&i=d (OMR Answer Sheet) 

ij dqN Hkh fy[kus ls iwoZ mlesa fn;s x;s lHkh vuqns'kksa 

dks lko/kkuhiwoZd i<+ fy;k tk;sA 

8. After the completion of the examination 

candidates should leave the examination hall 

only after providing their OMR Answer 

Sheet to the invigilator. Candidate can carry 

their Question Booklet. 

 8. ijh{kk lekfIr ds mijkUr ijh{kkFkhZ d{k fujh{kd dks 

viuh OMR Answer Sheet miyC/k djkus ds ckn 

gh ijh{kk d{k ls izLFkku djsaA ijh{kkFkhZ vius lkFk 

iz'u&iqfLrdk ys tk ldrs gSaA 

9. There will be no negative marking.  9. fuxsfVo ekfd±x ugha gSA 

10. Rough work, if any, should be done on the 

blank pages provided for the purpose in the 

booklet. 

 10. dksbZ Hkh jQ dk;Z  iz'u&iqfLrdk ds vUr esa] jQ&dk;Z ds 

fy, fn, [kkyh ist ij gh fd;k tkuk pkfg,A 

11. To bring and use of log-book, calculator, 

pager and cellular phone in examination hall 

is prohibited. 

 11. ijh{kk&d{k esa ykWx&cqd] dSydqysVj] istj rFkk 

lsY;qyj Qksu ys tkuk rFkk mldk mi;ksx djuk oftZr 

gSA  

12. In case of any difference found in English 

and Hindi version of the question, the 

English version of the question will be held 

authentic. 

 12. iz'u ds fgUnh ,oa vaxzsth :ikUrj.k esa fHkUurk gksus dh 

n'kk esa iz'u dk vaxzsth :ikUrj.k gh ekU; gksxkA 

Impt. : On opening the question booklet, first check that all 

the pages of the question booklet are printed properly. 

If there is any discrepancy in the question Booklet, 

then after showing it to the invigilator, get another 

question Booklet of the same series. 

 egRoiw.kZ % iz'uiqfLrdk [kksyus ij izFker% tk¡p dj ns[k ysa fd 

iz'u&iqfLrdk ds lHkh i"̀B HkyhHkk¡fr Nis gq, gSaA ;fn 

iz'uiqfLrdk esa dksbZ deh gks] rks d{kfujh{kd dks fn[kkdj 

mlh fljht dh nwljh iz'u&iqfLrdk izkIr dj ysaaA 


